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Xpressbillpay Account Creation

     

Creation of account

1. Go to  https://www.xpressbillpay.com/
2. Click the Create a New Account link
3. You will be prompted to enter your email address, create, and 

confirm a password.
4. Xpressbillpay will send a confirmation email to the address used 

for registration.  Verify your email address by clicking the “Verify 
Email” button.  Xpressbillpay will confirm verification of your 
email 

5. Choose account type “personal,”  fill out all the required fields 
and agree to the terms and conditions

Add New Account

1. Click the “Accounts” tab at the top of the page
2. Choose the City of Manzanita, Or as your billing location
3. Choose the bill type as “Transient Lodging Tax” and enter your 

account number and city supplied PIN #
4. Hit the “Locate Account” button to add your account   

Locating and Filing of Quarterly Taxes

1. After closing the page you will be directed to the Tax Returns 
page in Xpressbillpay.  Your Account name, account number, 
and the City of Manzanita will be listed.

2. You will be able to see any and all accounts created under 
that account number on the right-hand side of the screen.

https://www.xpressbillpay.com/


3. Click the green “View” button to go to the 
Unfiled/Filed/Pending Returns page

4. Select the year in which the tax filing will take place
5. In the Unfiled Taxes line, select the quarter in which you will be 

filing the tax form
6. Fill out the tax form.  Only lines 1, 2a – 2e, and 11 are fillable.
7. Once filled out, you have the choice to save without filing or to 

file the return
8. If there are taxes due after the return has been filed, you can 

pay by clicking the  green “Pay Now” button.  You can also 
pay by clicking the shopping cart at the top of the page

You can create a pdf of the tax filing along with your account 
information, and any balance due by clicking on the pdf 
symbol at the top right side of the webpage

Payment options include ACH/EFT eCheck which will incur no 
service fees or credit card (Visa, MasterCard, Discover).  A 3% 
service fee will be charged on all credit card payments.

Checkout

1. Select Pay Method -> Add a New Payment Method
2. Choose Payment Type and fill all the required fields
3. Review and confirm payment amount.
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CITY OF MANZANITA

Quarterly Transient Lodging Tax Report – Instructions

General Requirements
• Enter only the required figures; the form will calculate totals.
• Submit both the form and payment by the due date to avoid penalties. Late or 

incorrect submittals may incur staff time charges.
The City is entitled to collect reasonable auditing costs by City staff and/or 
auditor fees to determine or re-determine Taxes owed to the City. 

Line Instructions

Line 1. Gross Rent
Enter the total amount of all consideration charged to the transient for occupancy- 
including all fees assessed by the owner, their agent, or a Transient Lodging 
Intermediary, whether or not received by the owner, that is not optional or refundable, 
excluding taxes.  Rent is reported each quarter on stays that were completed in that 
quarter.

Line 2. Allowable Deductions
- 2a: Rent for stays of 30+ consecutive days.
- 2b–2e: Rent collected by intermediaries (VRBO, Expedia, Airbnb, Evolve) who remit 
taxes directly. Do not enter the tax they paid.
- 2f: Total deductions (sum of 2a–2e).
Note: You are responsible for ensuring intermediaries remit correct taxes.

Line 3. Taxable Rent
Calculated as Line 1 minus Line 2f.

Line 4. Tax Calculation
The form applies the 9% tax rate.

Line 5. Collection Fee
Deduct 5% of Line 4 (retained by you).

Line 6. Total Tax Due
Line 4 minus Line 5. Submit this amount unless taxes were fully remitted by 
intermediaries.
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Line 7. Penalties
- 7a: One month late: Greater of 10% of Line 6 or $100.
- 7b: Two months late: Additional greater of 15% of Line 6 or $150.

Line 8. Interest
Add 1% of Line 6 per month (or portion) after delinquency begins.

Line 9. Total Penalties & Interest
Form calculates total of Lines 7a, 7b, and 8.

Line 10. Tax + Penalties & Interest
Line 6 plus Line 9.

Line 11. Adjustments
Enter corrections for prior over/underpayments as directed by staff.

Line 12. Final Amount Due
Total owed with this report.

Submittal and Payment

              Tax forms and tracking of status can be found at: 
          STR Owner Status & Waitlist – City Of Manzanita
        

Email the completed form as a PDF attachment to:
      STRprogram@ci.manzanita.or.us.  Do not paste it in the email body.

Pay online at: Xpress Bill Pay.
o E-check: No fee.
o Credit card: Processing fee applies

Important Information
• Chronic Late Submittals: Per Ordinance 10-03 Section 4 “Failure to submit timely 

reports and make timely payment of Short-Term Rental taxes due may result in 
revocation of the Owner’s Short-Term Rental License.  This provision applies to all 
“Persons responsible for transient lodging tax reporting and payment for a given 
Short-Term Rental.”

• Audits: As outlined in Ordinance 16-03 Section 14, you are reminded to retain all 
information for a period of three and one half (31/2) years as the City has the 
right to conduct audits.  The owner is responsible for any back taxes and 
penalties which would be due and payable upon notification from this office.

https://ci.manzanita.or.us/str-portal/
mailto:STRprogram@ci.manzanita.or.us.
https://xpressbillpay.com/
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• Determinations: As stated in Ordinance 16-03 Section 17, the City is entitled to 
collect reasonable auditing costs by City staff and/or auditor fees to determine 
or re-determine Taxes owed to the city.

• Penalties & Interest:  Per Ordinance 16-03 Section 8, “Every penalty imposed and 
such interest as accrued under the provisions of this Ordinance shall be merged 
with and become part of the Tax required to be paid.”

• Fraud/Evasion: Per Ordinance 16-03 Section 8, “If the Tax Administrator 
determines that the nonpayment of any remittance due is due to fraud or intent 
to evade, a penalty of twenty-five percent (25%) of the amount of the tax will be 
added in addition to the penalties and interest assessed.

• Violations: Per Ordinance 16-03 Section 18 “Violation of any provision of this 
Ordinance shall be considered a Class A Civil Infraction enforceable under the 
procedures described in Manzanita Ordinance No. 15-01 and subject to 
penalties described therein.  Per Ordinance 10-03 Section 6 “failure to comply 
with Transient Lodging Tax Ordinance 16-03 shall (1) result in an immediate 
violation and (2) provide grounds for immediate revocation of the Owner’s Short-
Term Rental License.” 

For details, see full ordinances:
- Ordinance 16-03 – Transient Lodging Taxes
- Ordinance 10-03 – STR Regulations

https://ci.manzanita.or.us/wp-content/uploads/2021/04/Ordinace-16-03-Transient-Lodging-Taxes.pdf
https://ci.manzanita.or.us/wp-content/uploads/2021/10/Ordinance-10-03-STR-regulations-revised-09.08.2021.pdf
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How to convert a picture to a pdf

On Windows
Open Start 

. Click the Windows logo in the bottom-left corner of the screen. The Start menu 
will pop up.

• Alternatively, if you have a picture that you want to convert on 
your desktop or in another similarly accessible location, right-click 
the picture, select Open with, and click Photos to open the picture 
in the Photos app.

Type photos . This will search your computer for the Photos app, which is where all of 
your computer's pictures are stored.

Click Photos. It should be at the top of the Start menu.

Select a picture to convert. Click a picture that you want to turn into a PDF to 
open the picture.

• If you want to create a PDF with more than one image in it, first 
click Select in the upper-right side of the Photos window, then click 
each photo that you want to add to the PDF.

• If you don't see the image you're looking for, click the More tab 
and select Folders. You can then click Add a folder and select the 
folder to which you've saved your photo so it will be indexed by 
the Photos app.

https://www.wikihow.com/Convert-Images-to-PDF#/Image:Windowsstart.png
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Click the printer icon. You will see this in the upper-right corner of the window. 
Alternative, you can press Ctrl + P to open the print dialog screen.

Select Microsoft Print to PDF as the printer. To do this, just click the drop-down menu 
at the upper-left corner of the window, and then choose this option. If it was 
already selected, there's no need to make any changes here.
Click the Print button. It's at the bottom-left corner of the window. Don't worry, this won't 

actually print your document—it will virtually "print" it as a PDF file instead.

Enter a file name. Type a name for your PDF into the "File name" text box near the 
bottom of the window.

Select a save location. Click a folder on the left side of the window to select it as your 
PDF's save location.

Click Save. It's one of the two buttons in the bottom-right corner of the window. This 

saves your photo as a new PDF file.
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How to convert a picture to a pdf
On Mac

Open the image you want to convert in Preview. To do this, just double-click the 
image on your computer—it will open in Preview by default.

• If the image opens in an app other than Preview, right-click (or 
press Control as you click) the image, choose Open with, and 
then select Preview.

• If you want to add more images to the current file that you plan 
to turn into a PDF, click the View menu at the top and 
select Thumbnails. Then, drag any additional photos you want to 
add to the sidebar.[1]

• If you want to rearrange the order of the images in the file, drag 
their thumbnails to the desired positions in the sidebar.

Click the File menu. It's at the upper-left corner of the screen.

Click Export on the menu. This opens options for exporting the document. If you are 
using newest version of macOS, you can also click on Export as PDF and then skip to 
Step 5 for saving the pdf version of image.

Select PDF from the "Format" menu. When you choose this option, you can also choose 
to encrypt the file by adding a password, or to add a Quartz filter (such as a sepia 
tone) to the final document.

Name the document and click Save. This save the image(s) as a PDF file.

https://www.wikihow.com/Convert-Images-to-PDF
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How to convert a picture to a pdf
iPhone or iPad

Open the Photos app.  It's the multicolored flower icon on your home screen or in your 
App Library.

Tap the photo you want to convert. You can tap the Albums tab at the bottom 
first to browse by album or select Library at the bottom-left to scroll through your 
camera roll.

• If you want to select multiple photos to add to your PDF, 
tap Select at the top-right corner of the screen, then tap each 
photo that you want to select.

Tap the "Share" icon 

. It's the blue square with an arrow at the bottom-left corner of the screen. This 
opens the sharing menu.

Tap Print on the sharing menu. If you don't see this option, swipe up on the sharing menu 

to display the options below the icons.

Zoom in on the image preview to open it in PDF view. On the "Printer Options" 
page that expands, you'll see a preview of your image (or, if you selected 
multiple images, a preview of the first image). To view it as a PDF, place two 
fingers on the image preview and spread them away from one another—a 
reverse pinch motion. This opens the selected picture(s) in a PDF preview.

• If your iPhone has 3D Touch, you can press down on the preview to 
open it in a new window and then press down harder to open the 
PDF preview.

Tap the "Share" icon 

. This time, you'll see this blue square with an up-arrow at the top-right corner. in 
the top-right corner of the screen. This will open a menu at the bottom of the 
screen.

https://www.wikihow.com/Convert-Images-to-PDF#/Image:Iphoneblueshare2.png
https://www.wikihow.com/Convert-Images-to-PDF#/Image:Iphoneblueshare2.png
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Tap Save to Files. This option icon is in the bottom row of the menu. If you don't see it, 

swipe up on the sharing menu first.

Select a save location. First, you'll notice that the top of the screen says 
"Photo.pdf" will be saved to (location)." That means your iPhone now knows to 
create a PDF from the selected photo(s). Choose the location on your iPhone or 
iPad where you'd like to save the PDF.

• If you have iCloud Drive enabled, you can select it as your saving 
location instead of your iPhone or iPad.

• No matter where you save the image, you can create a new 
folder by tapping the folder icon with a plus sign in the upper-right 
corner if you'd like.

Tap Save. It's at the top-right corner of the screen. This saves the PDF to the selected 

location.



10-25

How to convert a picture to a pdf
On Android

Download the Image to PDF Converter app from the Play Store 

.
• Type image to pdf converter into the search bar and press Enter.
• Scroll down and select the app called Image to PDF Converter that has a 

black icon with a green sheet of paper, the word "PDF," and an arrow. The 
developer is DLM Infosoft.

• Tap INSTALL.

Open Image to PDF Converter. Tap OPEN in the Google Play Store once the app 
finishes downloading or tap the "Image2PDF" icon in your Android's app list—it's 
the same black-and-green icon you saw before.

Tap the plus button ＋. It's at the bottom-right corner.

Tap Gallery. This tells the app to open your image gallery.
• If it's your first time using the app, you'll be asked to give it permission to 

access files on your Android first.

Tap the image(s) you want to convert. You can select one or more images to add to 
your PDF. You should see a checkmark appear at the center of each selected picture.

Tap Done. It's at the top-right corner. This prepares a PDF document containing 
the selected image(s).

Tap the PDF icon. It's a white sheet of paper with a red design (the Adobe logo), 
and you'll see in the upper-right corner of the screen.

https://www.wikihow.com/Convert-Images-to-PDF#/Image:Androidgoogleplay.png
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Enter the PDF details. Type a name for the PDF into the top field. Then, you can 
make some optional adjustments, such as locking the file with a password or 
compressing it to a smaller size.

Tap OK to save the file. It's at the bottom-right corner of the window. This saves 
the PDF to a folder called DLMImageToPdf in your Android's default storage 
location. You'll be taken to this location immediately once the file is created.


